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For virtually any Operating System (OS) that utilizes a Graphical User Interface (GUI), for user interaction, will have 
a desktop. The desktop is the focal point for all user interaction; the desktop gives the user easy access to both user 
programs and system tools, and at the same time it manages all of these programs in a way that optimizes user 
productivity (at least that is the goal). Below is a picture of a Windows XP desktop in "Classic" Mode. The Classic 
desktop has the look and appearance of the older Microsoft operating systems, but still has all of the new features 
that are included with Windows XP. Below, the key features of the desktop are explained in greater detail.  

 
      A Windows Desktop 

 
Desktop Icons 

 

  The My Computer icon is the access point to all of the files on your computer. The screen that immediately 
appears shows all of the Local Drives (Hard Drives), Optical Drives (CD-ROMs, DVD-ROMs, CD-RWs, etc.), Removable 
Drives (Floppy Drives, Zip Drives, Portable Hard Drives, Digital Cameras, etc.), and Mapped Network Drives. If you 
ever need to find a file, select a medium, and then use the "Search for files and folders" utility on the left, or use the 
Start Button, select Search, and then choose the appropriate item. 

 
 The My Network Places icon is a shortcut to a location in the Explorer hierarchy that shows all of your 
Network Places, which are places within your network that you have visited. On the left there are four tools 

under "Network Tasks" that any user which is connected to a network should be familiar with.  

• Add a network place - This option allows you to add places indiscriminately. Using this tool allows you to 
specify a location in your network, a Web Site, ftp address, etc. These places are allot like the Favorites in 
Internet Explorer, merely shortcuts to make your time more productive.  

• View network connections - Your computer can have multiple connections to different networks which could 
consist of dial-up locations, wired network connections, wireless network connections, etc. Clicking on any of 
these items displays the properties for that connection. If the connection is active it displays a window that 
displays connection statistics, and if you click on the Support tab, there is a useful "Repair" button. If you 
ever have any network problems, you should click on this button first.  

• Set up a home or small office network - Although most experts would not choose to use this feature to set 
up a network, people who do not know or do not want to know how to set up a network will find this tool 
invaluable, as it requires almost no knowledge of networks or their policies to set up.  

• View workgroup computers - This option allows you to browse through computers in your workgroup and/or 
domain. Only computers that are sharing resources on the network will be visible, and then you will be only be 
able to browse those resources if the Administrator of that computer has given your account permission.  
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The My Documents icon is, by default, a shortcut to the folder: 
 
Windows Volume\Documents and Settings\User Name\Documents\ 
 
Since the folder is dependant upon the current user that is logged in, every user's My Documents folder is different. 
Depending upon the version of Windows XP you are using, and your user classification, no other user can access any of 
the files is this folder The My Documents folder is the default location to save all of your documents, downloaded 
files, pictures, and music. 

 

 

The Recycle Bin is the place where all of the files you delete from your system immediately go by default. This is a 
safety feature which prevents you, or a third party, from accidentally deleting important files from your computer. 
The Recycle Bin is actually a hidden folder on your hard drive, on which a certain percentage of it's disk space is 
dedicated this folder. Once the contents of the Recycle Bin reaches its limit the oldest items are permanently 
deleted to make room any new items you delete. Some find the Recycle Bin, as a whole, an annoyance. It is possible to 
bypass the Recycle Bin on individual occasions by holding down while deleting your items, or permanently, by right-
clicking on the Recycle Bin and altering the properties. 

The Taskbar 

The Taskbar is a portion that takes up the largest portion of the whole; in the classic Windows theme it is gray, but 
blue in the XP theme. The vast majority of the programs that you launch will immediately show up here as a 
rectangular box with corresponding title and icon. Windows includes this feature in order to allow the user to easily 
switch between programs. In newer versions of Windows, there is a feature incorporated into the Taskbar that 
stacks multiple windows of the same type on top of one another in the same rectangle when the Taskbar becomes full. 
Clicking on one of these grouped items will show you a sub menu of windows instead of bringing a program to the 
foreground. Another, alternative, method of switch programs is to hold down , and then push .  

 

The Taskbar contains four items: 1) the Start Menu (explained later), 2) the System Tray, 3) the Quick Launch Bar, 
and, 4) for lack of a better word, the Taskbar. Both the Quick Launch Bar, and the Taskbar as a whole can be resized 
to your preference. If it seems that you cannot resize these items, simply right-click on them, and make sure that 
"Lock the Taskbar" does not have a check next to it.  

System Tray  

The System Tray is, unfortunately, an often overlooked portion of the desktop. The System Tray is, by default, the 
rightmost portion of the Taskbar, and is a holding place for programs which are running in the background, almost 
always, anonymously. Good management of the System Tray is essential for a smooth running computer since it is an 
indicator of how many programs are launched at start-up; as common-sense suggests, the more icons that are present, 
the more resources are being consumed. Most of the programs that appear in here are worthless and do nothing more 
than slow down your computer. Most multimedia applications such as Real One Player, Quicktime, Winamp, etc. all 
launch needless programs at startup and you could free up valuable resources by disabling them. With that being said, 
the System Tray is an invaluable place to have programs run that would otherwise clutter your Taskbar. Many 
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programs have an option to hide in the Taskbar when minimized; you should consult the documentation of your program 
for information on how to accomplish this.  Windows XP has a feature that hides InActive icons in the system tray.  

Quick Launch Bar  

Windows XP, by default, has the Quick Launch bar turned off. I, however, find this feature invaluable since I do not 
like the new XP style Start menu. To turn it on, simply right-click on the Taskbar, and alter the relevant settings in 
the properties dialog. The Quick Launch Bar is a place to store shortcuts to your most commonly used programs 
and/or documents. With the shortcuts here, you can launch the programs without minimizing your currently running 
programs, or browsing the Start Menu. You can add shortcuts here simply by dragging them from an existing location, 
and you can delete unnecessary items by right-clicking on them and selecting delete.   

The Start Button   

The Start Menu Button is located on the Task Bar, which is most commonly found on on the bottom half of the screen. 
The Start Button launches the Start Menu, which is the main access point to both the user programs that are 
installed on the system, and the system resources which control the behavior of the OS. If you are looking for a 
program or a system setting, this is the best place to start.  

The Start Menu 

There are two different version of the Start Menu, a "Classic" and a "XP" version. Unlike all of the other differences 
we have seen this thus far, the differences between these two versions extends beyond their look and feel. The 
"Classic" Start Menu is similar to those found in the previous version of Windows, and is thus probably more 
comfortable to use for those who have upgraded from earlier versions. To switch between these two versions, right-
click on the Taskbar, select properties, then click on the "Start Menu" tab.  

Regardless of the version you choose to use you will want to be familiar with the Programs tab. The Programs tab is 
the default location that installers place program execution shortcuts. You navigate the menu by moving your mouse 
over the appropriate icon or folder. The folders expand to reveal another sub menu, allowing you to navigate further 
into the hierarchy, and the icons launch programs when you click on them. You can place additional shortcuts by 
creating additional folders or shortcuts in the Start Menu folder in your user settings. I suggest only altering objects 
beneath the Programs level since the "XP" version of the Start Menu will reflect these items below the Programs level 
regardless.  

To get to the appropriate folder:  

1. Launch My Computer  
2. Select the volume in which Windows is installed on (C: by default)  
3. Navigate to Windows Volume:\Documents and Settings\User Name\Start Menu\  

Your Start Menu is representative of the folders and shortcuts that are found in this folder, and any changes you 
make to this folder will affect your Start Menu. You will note that all of the folders and shortcuts in the Start Menu 
will not be in this folder. The rest of the icons that you are looking for are in the folder: 

Windows Volume:\Documents and Settings\All Users\Start Menu\  

You should note that any changes that you make in this folder will affect all of the other users on the system.  
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Two other options on either Start Menu are Help and Support and Run. Help and Support is the first place to go if you 
are looking for information on how to do something in the OS; if you are looking for information on how to do 
something within a program you should consult the program's help file, which can usually be found on the toolbar at 
top. Run is a tool that can be used to execute programs, specifically system programs such as msconfig, or cmd. 
msconfig allows you to configure windows startup options, and cmd launches a command line interface similar to an old 
OS known as DOS.  

There are many of options that can make your Start Menu fit your personal style. To look at these options right-click 
on the Taskbar, select properties, click on Start Menu, and then click on customize.  

Classic Start Menu 

The Classic Start Menu, is a far simpler design than the version found in the XP theme. This version is much more 
tree-like, with very few options at the base level; most everything found here is a branch that expands into other 
areas. A few components that any Windows user should be familiar with are:  

• Settings - Contains the Control Panel, which will be discussed in detail on the next page, and other individual 
settings that you can choose from in the customization options such as Printers and Network Connection; 
these items themselves are components of the Control Panel  

• Search - This is the fastest way to find files on your computer. It can also be used to search the internet, 
and 3rd party programs often install other options in here that are program specific.  

• Windows Update - This option is a quick link to the Microsoft web site that is used to keep your Windows 
Operating System up-to-date with all of the latest patches and upgrades. It is always a good idea to make 
sure that you check for updates since security updates are released constantly.  

One particular customization option that you should take a look at is the "Personalized Menus" option. With this option 
on, programs you don't use that often are not displayed immediately when you browse through Programs, and you have 
to click on the double arrows located at the bottom of the menu to display all of the programs. This option is on by 
default, but can often hide programs that you installed on your computer.  



                                           XP Basics                            Page 5 of 11 

 
An example of browsing the Start Menu in the Classic mode  

 

The XP Start Menu 

The XP Start Menu may look very different than the Classic Start Menu, but it is very similar in many ways; many of 
the features have just been moved around. The XP Start Menu is very flat in the sense that it has no layers by 
default except for the Programs tab. On the right side of the Start Menu are the programs and system controls that 
would normally either be found on the Desktop or in the Settings tab. You can, by editing the Taskbar and Start Menu 
control panel, make these icons expand into sub components. The left side of this Start Menu is much more 
interesting. The top two components are whatever shortcut is registered with Windows as your default Internet 
Browser and Email Application. Although there are none pictured on the Start Menu below the rest of that space 
would be dedicated to the programs that you use most frequently; the number of which can be altered through the 
Taskbar and Start Menu control panel. The last item found is your full listing of programs.  
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The XP Styled Start Menu  

Explorer 

Windows Explorer is the Desktop Manager, File Browser, and Internet Browser all rolled into one package. Explorer is 
so integrated into the Windows framework that it was once the subject of allot of controversy from competing 
internet Browsers, who claimed that Microsoft was involved in unfair business practices. That being said, if you want 
to be able to use Windows well , you will need to learn the details of this program.  

 

 

The Task Pane 

The Task Pane is a advent of Windows XP, and is very useful to those who do not know keyboard shortcuts for 
completing certain tasks or jumping to certain special locations within your computer. You can minimize/maximize any 
of the Tasks by simply clicking on the arrow to the right of the heading.  

File/Folder Specific Tasks 

These tasks appear when you have entered a folder which has a defined type other than "Documents". The tasks that 
will appear here are suited for completing tasks on the given type; such as:  
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• View a slide show for a picture folder  
• Shop for music online for a music folder  
• Play all for a video folder  

You can customize your folder types by right-clicking on the folder and selecting the Customize tab. In this tab there 
is a drop down menu which will allow you to change the type of files this folder contains. Many other options may 
appear here when you are in special locations such as the Control Panel, the root of your Windows Volume, the Program 
Files directory, and the Windows directory.  

File and Folder Tasks 

These tasks are those for which you would want to perform on any file or folder such as: sharing, renaming, moving, 
copying , and deleting. This is also where you would want to go if you needed to create a new folder.  

Other Places 

If you need to jump to a place quickly in the Windows Infrastructure you could do so quickly by using these shortcuts. 
The shortcuts that appear here are: My Computer, My Documents, and My Network Places.  

Details 

This is less a group of tasks, and more a tool for displaying file/folder specific information. When displayed this part 
of the Task Pane will display file details similar to those found in the Details view mode. The information displayed 
here consists of File Name, File Type, Size, Date Modified, Document Specific Information, and, if available, Preview 
Information in the format of a thumbnail.  

Status Bar 

The Status Bar, by default, has been turned off in Windows XP, and in Microsoft fashion, I fully expect it to 
disappear by the next rollout of the Windows Operating System. However, we should always take advantage of things 
while they are still around; one can turn on the Status Bar by going to View -> Status Bar. This bar is useful to 
Windows users no only in Windows Explorer, but in Internet Explorer as well. In Windows Explorer it shows you 
rudimentary file details which are specific for you file type. In Internet Explorer the status bar shows you useful 
messages such as: page load progress, page messages, and page errors.  

Address Bar 

The address bar allows the user to type in a url or directory and move straight there without any further navigation 
as well as letting the user know where they are currently on the internet/file system. The wonderful thing about the 
address bar is that it allows you to seamlessly go between the two flavors of explorer; if you are on the internet type 
in "c:\", or type in "www.washington.edu" to go to the UW home page.  

Standard Buttons 

The standard buttons operate the same way in both Windows Explorer and Internet Explorer. The common buttons 
are:  

• Back - Navigates to the last page/folder that you were viewing.  
• Forward - If you have browsed backwards using the back button you may use this button to move forward 

through the views you backed out of  
• Home - Only available on Internet Explorer; takes the user to their home page as specified in the Internet 

Options. If this button is used in Windows Explorer, it will still take the user to the homepage.  

http://www.washington.edu
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• Refresh - Allows you to refresh the current web page with the latest versions from the server, or in 

Windows Explorer refreshes the file list that is currently displayed.  
• Search - Lets you search either the internet for web sites or your file system for certain files.  
• Stop - This button stops your browser from continuing to load the current page if it is in the process of doing 

so. This button has no function in Windows Explorer, even though it is present.  
• Up - Only available in Windows Explorer; this button allows you to move one directory up into the file system. 

For instance: If you were at C:\Windows\, pressing the Up Button would take you to C:\.  

You can, of course, customize this feature by going to View -> Toolbars -> Customize. Other buttons you can add 
include: Copy, Paste, Cut, Copy To, Move To, Map Drive, and Properties.  

Viewing Options 

Windows offers it's users a variety of methods to view their files. Each method has it's own benefits/disadvantages 
when compared to the others, but most choose their viewing method simply based on their personal preference. Each 
folder is unique, Windows will remember the view mode settings for every folder, thus it will appear the same every 
time you visit the folder. Click on View in the toolbar and select your desired view to change your current view mode.  

Details View 

The Details View disseminates the most information about multiple files than any other view mode. All the information 
is tightly displayed, which makes this view the favorite for viewing files which contain no extra information such as 
pictures or movies. You can add or delete the information topics displayed by right clicking on the bar with the topic 
names on them, and then checking, or un checking, the items you want displayed. Another useful feature of this 
display is the ability to sort the files in the view simply by clicking on one of these topics.  

 
Explorer viewing files in the Details Mode  

List View 

The List View is similar to the Details View, in that it lists the filename, and associated program icon, but no preview 
information. Unlike the Details View, this view does not list any of the extra information such as: Date Modified, Size, 
or Type. This would be the ideal option to choose if you had allot of files you needed to see all at once, but did not 
need the preview or extra information that other views provide.  
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Icons View 

The Icons View displays icons, which are baed on their associated program, and the file name. Some file types will display preview 
information; this, however, is a function of it's associated program, and not Windows. Windows, by default, only shows preview 
information in the Thumbnail and Filmstrip View. An example of a program that displays preview information is Adobe Photoshop, 
which displays preview information for pictures as well as Photoshop Document (PSD) Files, an example of such is displayed below. 

 
Explorer viewing files in the Icons Mode 

 

 

 

Tiles View 

The Tiles View is the same as the Icons View with the exception that it displays some extra information along with 
the file name such as: File Type, Size, Picture Dimensions, and Music author and title. 
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Explorer viewing files in the Tiles Mode  

Thumbnails View 

The Thumbnails View is the first view which Windows decides to display preview information of its own. This 
information is usually only displayed on files which contain multimedia content such as: Pictures (BMP, GIF, JPG, and 
PNG), and Movies (MPG, ASF, and AVI), but sometimes other documents such as Office Documents (DOC, XLS, and 
PPT) will display preview information as well.  

 
Explorer viewing files in the Thumbnails Mode  

 

 

 

Filmstrip View 

The Filmstrip View is excellent for browsing through multiple pictures at once. The biggest difference 
between this view and the other views which show you preview information is that a large preview is 
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generated above the thumbnails of the file currently selected. Also, this view gives the user primitive 
picture manipulation features below the large preview. Currently you are only allowed to rotate the 
image, but there will likely be more options in the next versions if windows. 

s.  
Explorer viewing files in the Filmstrip Mode 

You can change all of the folders in you computer to conform to the same viewing method by settings them all in the 
Folder Options control panel, or by going to Tools -> Folder Options -> View, and then clicking on the Apply to All 
Folders button. This will make every single folder display exactly as the one you are currently viewing.  

 


